
Completing the OGE Form-1353

Saving the Workbook
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-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)
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-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent 
possible, agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All 
submissions must be made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still 
submit a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or 
the SF-326 (in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-
colored cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected 
so that you can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages 
refer to the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right 
click, select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" 
checkbox at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left 
click the name of an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  
Select "OK".  A new sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.
To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that 
each tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that 
each tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the 
upper right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over 
the cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will 
remain highlighted.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option 
to "Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the 
excel file as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency 
Name], [Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate 
information. If there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of 
the spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell 
to the left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-
agencies: Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the 
Department ABC worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's 
position in the workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The 
Department XYZ report would read 2 for Page-- referring to its order as the second report-- and 2 for Of 
Pages-- referring to the total number of sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see 
how the file will look when it is printed.
Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission

Semiannual Report of Payment Accepted



Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President



Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acronym for your      



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC

    



EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP



OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

                 r agency, please contact OGE at 1353travel@oge.gov



PAGE OF PAGES YEAR

2013

Agency Contact:
[Replace with 
Agency Contact 
Name]

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Jermaine Sutton Orleans Liberation 
Ceremony 8/15/2019 Orleans, France Hotel X $220.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              

Battalion Commander Franco-American 
Association 8/16/2019 08/15/2019-

08/17/2019                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Doug Bram Orleans Liberation 
Ceremony 8/15/2019 Orleans, France Hotel X $220.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              

Battalion Command 
Sergeant Major

Franco-American 
Association 8/16/2019 08/15/2019-

08/17/2019                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Adriana Izaguirre Orleans Liberation 
Ceremony 8/15/2019 Orleans, France Hotel X $220.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              

JNOC Platoon Leader Franco-American 
Association 8/16/2019 08/15/2019-

08/17/2019                            

BENEFIT SOURCE

Franco-American 
Association 

BENEFIT SOURCE

Franco-American 
Association 

BENEFIT SOURCE

Franco-American 
Association 

BENEFIT SOURCE

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

[Replace with Agency Contact 
Email]

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

Asia Pacific Forum 
Pacific Rim Foundation 

3

LOCATION

TRAVEL DATE(S)

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

[REPLACE  WITH REPORTING AGENCY NAME]
[REPLACE WITH SUB-AGENCY NAME] NEGATIVE 

REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

REPORTING 
PERIOD: 

OCTOBER 1, 
2012- MARCH 

31, 2013

REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 

30, 2013



PAGE OF PAGES YEAR

1 1 2019

Agency Contact: CPT Katherine Faoro

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Jermaine Sutton Orleans Liberation 
Ceremony 8/15/2019 Orleans, France Hotel X $220.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              

52nd Signal Battalion 
Commander

Franco-American 
Association 8/16/2019 08/15/2019-

08/17/2019                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Doug Bram Orleans Liberation 
Ceremony 8/15/2019 Orleans, France Hotel X $220.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              

52nd Signal Battalion 
Command Sergeant 
Major

Franco-American 
Association 8/16/2019 08/15/2019-

08/17/2019                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Adriana Izaguirre Orleans Liberation 
Ceremony 8/15/2019 Orleans, France Hotel X $220.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              

JNOC Platoon Leader Franco-American 
Association 8/16/2019 08/15/2019-

08/17/2019                            

REPORTING 
PERIOD: 

OCTOBER 1, 
2018- MARCH 

31, 2019

REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 

30, 2019

NEGATIVE 
REPORT

NETCOM - 2d Theater Signal Brigade

katherine.c.faoro.mil@mail.mil

No.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

Department of Defense

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

TOTAL 
AMOUNT

EX

LOCATION BENEFIT SOURCE

Asia Pacific Forum 
Pacific Rim Foundation 

TRAVEL DATE(S)

TRAVELER EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

BENEFIT SOURCE BENEFIT 
DESCRIPTION

2

LOCATION BENEFIT SOURCE

Franco-American 
Association 

TRAVEL DATE(S)

1

LOCATION BENEFIT SOURCE

Franco-American 
Association 

TRAVEL DATE(S)

3

LOCATION BENEFIT SOURCE

Franco-American 
Association 

TRAVEL DATE(S)



PAGE OF PAGES YEAR

1 2 2019

Agency Contact:
[Replace with 
Agency Contact 
Name]

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Chris Mayer

Middle States 
Commission on Higher 
Education (MSCHE) 
Team Visit

4/1/2019 College Park, MD Hotel X $260 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Transportation X $472 

COL MSCHE 4/2/2019 03/31/2019-
04/02/2019 Meals X $120 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Caleb Shifrin Space Weather Workshop 4/3/2019 Boulder, CO Hotel X $294.72 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Meals X $50 

Cadet Space Weather Prediction 
Center 4/3/2019 04/02/2019-

04/04/2019 Registration Fee X $205 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Seth Barbrow Space Weather Workshop 4/3/2019 Boulder, CO Hotel X $294.72 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Meals X $50 

Cadet Space Weather Prediction 
Center 4/3/2019 04/02/2019-

04/04/2019 Registration Fee X $205 

BENEFIT SOURCE

MSCHE

BENEFIT SOURCE

University Corporation for 
Atmospheric Research

BENEFIT SOURCE

University Corporation for 
Atmospheric Research

BENEFIT SOURCE

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

[Replace with Agency Contact 
Email]

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

Asia Pacific Forum 
Pacific Rim Foundation 

3

LOCATION

TRAVEL DATE(S)

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

United States Military Academy
West Point NEGATIVE 

REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

X

REPORTING 
PERIOD: 

OCTOBER 1, 
2018- MARCH 

31, 2019

REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 

30, 2019



PAGE OF PAGES YEAR

2 2 2019

Agency Contact: MAJ Gallagher

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Kyle Wolfley International Achievement 
Summit 9/13/2019 New York, NY Hotel X $576 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Transportation X $210 

CPT Catherine B. Reynolds 
Foundation 9/15/2019 09/13/2019-

09/15/2019 Meals X $190 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Chris Mayer

Middle States 
Commission on Higher 
Education (MSCHE) 
Accreditation Visit

9/15/2019 Kings Point, NY Hotel X $273 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Transportation X $58 

COL MSCHE 9/17/2019 09/15/2019-
09/17/2019 Meals X $100 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Suzanne Nielsen
The Role of the US 
Military in Cyberspace 
Research Presentation

9/19/2019 Ithaca, NY Hotel X $126 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Transportation X $223.30 

COL Cornell University 9/19/2019 09/18/2019-
09/19/2019 Registration X $99 

TOTAL 
AMOUNT

United States Military Academy
West Point

NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

x

REPORTING 
PERIOD: 

OCTOBER 1, 
2018- MARCH 

31  2019

LOCATION

TRAVEL DATE(S)

REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 

30, 2019

BENEFIT 
DESCRIPTION

3

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

TRAVEL DATE(S)

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION BENEFIT SOURCE

BENEFIT SOURCE

1

LOCATION

TRAVEL DATE(S)

matthew.gallagher@westpoint.edu

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

Asia Pacific Forum 
Pacific Rim Foundation 

Catherine B. Reynolds 
Foundation

BENEFIT SOURCE

MSCHE

BENEFIT SOURCE

Ithaca, NY



PAGE OF PAGES YEAR

2019

Agency Contact: Ms. Courtney 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

David Gioe
   

Initiative Workshop 4/3/2019 Washington, DC hotel (2 nights) x 500
TRAVELER TITLE EVENT SPONSOR ENDING DATE 

[MM/DD/YYYY]
Assistant Professor Facebook 4/4/2019 3-4 October 2018
TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 

[MM/DD/YYYY]                               
Stephanie Pell Tech Ethics and 

Governance: 2019 4/18/2019 Durham, NC lodging x $350.00
TRAVELER TITLE EVENT SPONSOR ENDING DATE 

[MM/DD/YYYY] Air Transportation x 435.85
Assistant Professor Kenan Institute of Ethics

  
airport) x 70
meals (4) x $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Travis Russell
   

Connes Embedding 7/15/2019 Banff, Canada hotel x 890.25
TRAVELER TITLE EVENT SPONSOR ENDING DATE 

[MM/DD/YYYY] meals x 265
Assistant Professor

  
Research Station for 7/19/2019 July 14 & 19, 2019

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Travis Russell meet with colleague to 
collaborate on research 5/20/2019 Waterloo, Ontario, 

Canada lodging x 480
TRAVELER TITLE EVENT SPONSOR ENDING DATE 

[MM/DD/YYYY] transportation x 750
Assistant Professor University of Waterloo 05/23/2019 May 20 & 23, 2019                               
TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 

[MM/DD/YYYY]

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

                              
TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 

[MM/DD/YYYY]

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                            

                              
TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 

[MM/DD/YYYY]

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

                              
TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 

[MM/DD/YYYY]                               
                             

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                            

                              
TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 

[MM/DD/YYYY]                               
                             

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                            

                              
TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 

[MM/DD/YYYY]                               
                             

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                            
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2018  

TRUE APRIL 1 - 
SEPTEMBER 

FALSE
1

93

95

BENEFIT SOURCE

LOCATION

TRAVEL DATE(S)

TRAVEL DATE(S)

92

94

TRAVEL DATE(S)

LOCATION

TRAVEL DATE(S)
99

BENEFIT SOURCE

BENEFIT SOURCE

LOCATION

LOCATION BENEFIT SOURCE

BENEFIT SOURCE

LOCATION

TRAVEL DATE(S)

97

96

98
TRAVEL DATE(S)

BENEFIT SOURCE

BENEFIT SOURCE

BENEFIT SOURCE

LOCATION

TRAVEL DATE(S)

LOCATION

TRAVEL DATE(S)

LOCATION



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right 
click, select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" 
checkbox at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left 
click the name of an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  
Select "OK".  A new sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.
To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that 
each tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that 
each tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent 
possible, agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All 
submissions must be made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still 
submit a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or 
the SF-326 (in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-
colored cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected 
so that you can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages 
refer to the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of 
the spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell 
to the left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-
agencies: Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the 
Department ABC worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's 
position in the workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The 
Department XYZ report would read 2 for Page-- referring to its order as the second report-- and 2 for Of 
Pages-- referring to the total number of sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the 
excel file as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency 
Name], [Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate 
information. If there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option 
to "Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the 
upper right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over 
the cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will 
remain highlighted.



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see 
how the file will look when it is printed.
Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission

Semiannual Report of Payment Accepted



Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President



Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acronym for your      



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC

    



EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP



OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

                 r agency, please contact OGE at 1353travel@oge.gov



PAGE OF PAGES YEAR

1 1 2019

Agency Contact:
Marie Antoinette 
Joiner

REPORTING 
PERIOD: APR 1 
2019 - 30 SEP 

2019

OGE Form-1353
(OGE-Approved Alternative for SF-326)

February 2011

1353 Travel Report for Laurie Rush for the reporting period April 1, 2019 - September 30, 2019

No.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

X

U.S. Army
U.S. Army Forces Command

marie.a.joiner.civ@mail.mil / 910-
570-5923

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

TOTAL 
AMOUNTTRAVELER EVENT DESCRIPTION & 

EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

BENEFIT SOURCE BENEFIT 
DESCRIPTION



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right 
click, select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" 
checkbox at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left 
click the name of an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  
Select "OK".  A new sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.
To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that 
each tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that 
each tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent 
possible, agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All 
submissions must be made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still 
submit a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or 
the SF-326 (in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-
colored cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected 
so that you can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages 
refer to the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of 
the spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell 
to the left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-
agencies: Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the 
Department ABC worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's 
position in the workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The 
Department XYZ report would read 2 for Page-- referring to its order as the second report-- and 2 for Of 
Pages-- referring to the total number of sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the 
excel file as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency 
Name], [Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate 
information. If there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option 
to "Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the 
upper right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over 
the cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will 
remain highlighted.



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see 
how the file will look when it is printed.
Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission

Semiannual Report of Payment Accepted



Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President



Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acronym for your      



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC

    



EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP



OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

                 r agency, please contact OGE at 1353travel@oge.gov



PAGE OF PAGES YEAR

1 1 2019

Agency Contact: Lesley Cruce

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

                              

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              

                           

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

                              

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              

                           

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

                              

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              

                           

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

Headquarters, Department of the Army
U.S. Army Combat Readiness Center

NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

x x

REPORTING 
PERIOD: 

OCTOBER 1, 
2018- MARCH 

31  2019

REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 

30, 2019

3

LOCATION

TRAVEL DATE(S)

Asia Pacific Forum 
Pacific Rim Foundation 

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

lesley.a.cruce.mil@mail.mil

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

BENEFIT SOURCE

BENEFIT SOURCE

BENEFIT SOURCE

BENEFIT SOURCE



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right 
click, select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" 
checkbox at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left 
click the name of an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  
Select "OK".  A new sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.
To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that 
each tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that 
each tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent 
possible, agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All 
submissions must be made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still 
submit a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or 
the SF-326 (in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-
colored cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected 
so that you can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages 
refer to the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of 
the spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell 
to the left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-
agencies: Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the 
Department ABC worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's 
position in the workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The 
Department XYZ report would read 2 for Page-- referring to its order as the second report-- and 2 for Of 
Pages-- referring to the total number of sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the 
excel file as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency 
Name], [Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate 
information. If there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option 
to "Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the 
upper right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over 
the cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will 
remain highlighted.



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see 
how the file will look when it is printed.
Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission

Semiannual Report of Payment Accepted



Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President



Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acronym for your      



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC

    



EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP



OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

                 r agency, please contact OGE at 1353travel@oge.gov



PAGE OF PAGES YEAR

1 1 2019

Agency Contact:
LTC Christian 
Deichert

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

COL Kenneth Cole AAAA Army Aviation 
Mission Solutions Summit 4/14/2019

Gaylord Opryland 
Convention Center, 
Nashville, TN

Hotel X 417.6

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Transportation X 2359.74

Commander, 12th 
Combat Aviation 
Brigade (12th CAB)

AAAA 4/16/2019 14-18 April 2019 Meals X 274.5

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

CW5 Eugene Santos AAAA Army Aviation 
Mission Solutions Summit 4/14/2019

Gaylord Opryland 
Convention Center, 
Nashville, TN

Hotel X 835.2

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Transportation X 2552.56

Chief Warrant Officer, 
12th CAB AAAA 4/16/2019 14-18 April 2019 Meals + misc X 360.42

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

CSM Mark Smith AAAA Army Aviation 
Mission Solutions Summit 4/14/2019

Gaylord Opryland 
Convention Center, 
Nashville, TN

Hotel X 835.2

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Transportation X 2870.34

Command Sergeant 
Major, 12th CAB AAAA 4/16/2019 14-18 April 2019 Meals + misc X 365.33

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

DEPARTMENT OF DEFENSE
USAREUR, DEPARTMENT OF THE ARMY NEGATIVE 

REPORT
LOCATION AND 

TRAVEL DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]

X

REPORTING 
PERIOD: 

OCTOBER 1, 
2018- MARCH 

31, 2019

REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 

30, 2019

3

LOCATION

TRAVEL DATE(S)

Asia Pacific Forum 
Pacific Rim Foundation 

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

christian.l.deichert.mil@mail.mil

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

BENEFIT SOURCE

AAAA

BENEFIT SOURCE

AAAA

BENEFIT SOURCE

AAAA

BENEFIT SOURCE



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent 
possible, agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All 
submissions must be made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still 
submit a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or 
the SF-326 (in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-
colored cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected 
so that you can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages 
refer to the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right 
click, select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" 
checkbox at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left 
click the name of an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  
Select "OK".  A new sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.
To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that 
each tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that 
each tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the 
upper right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over 
the cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will 
remain highlighted.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option 
to "Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the 
excel file as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency 
Name], [Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate 
information. If there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of 
the spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell 
to the left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-
agencies: Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the 
Department ABC worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's 
position in the workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The 
Department XYZ report would read 2 for Page-- referring to its order as the second report-- and 2 for Of 
Pages-- referring to the total number of sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see 
how the file will look when it is printed.
Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission

Semiannual Report of Payment Accepted



Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President



Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acronym for your      



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC

    



EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP



OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

                 r agency, please contact OGE at 1353travel@oge.gov



PAGE OF PAGES YEAR

1 1 2019

Agency Contact: Michele T. Lacey

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

                              

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              

                           

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

                              

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              

                           

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

                              

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              

                           

BENEFIT SOURCE

BENEFIT SOURCE

BENEFIT SOURCE

BENEFIT SOURCE

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

michele.t.lacey.civ@mail.mil

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

Asia Pacific Forum 
Pacific Rim Foundation 

3

LOCATION

TRAVEL DATE(S)

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

US Army
US Army South

NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

x x

REPORTING 
PERIOD: 

OCTOBER 1, 
2018- MARCH 

31  2019

REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 

30, 2019



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent 
possible, agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All 
submissions must be made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still 
submit a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or 
the SF-326 (in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-
colored cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected 
so that you can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages 
refer to the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right 
click, select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" 
checkbox at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left 
click the name of an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  
Select "OK".  A new sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.
To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that 
each tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that 
each tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the 
upper right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over 
the cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will 
remain highlighted.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option 
to "Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the 
excel file as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency 
Name], [Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate 
information. If there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of 
the spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell 
to the left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-
agencies: Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the 
Department ABC worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's 
position in the workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The 
Department XYZ report would read 2 for Page-- referring to its order as the second report-- and 2 for Of 
Pages-- referring to the total number of sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see 
how the file will look when it is printed.
Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission

Semiannual Report of Payment Accepted



Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President



Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acronym for your      



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC

    



EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP



OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

                 r agency, please contact OGE at 1353travel@oge.gov



PAGE OF PAGES YEAR

1 1 2019

Agency Contact: Avis McMullen

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Frederick W. Bates Honor Flight 5/28/2019 Washington DC Air Transportation X $500 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Ground Transport 0

COL / KYDVA - 
Guardian Honor Flight 5/28/2019 5/28/2019 Meals 0

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

                              

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              

                           

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

                              

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              

                           

BENEFIT SOURCE

Honor Flight Bluegrass

BENEFIT SOURCE

BENEFIT SOURCE

BENEFIT SOURCE

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

avis.w.mcmullen.ctr@mail.mil

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

Asia Pacific Forum 
Pacific Rim Foundation 

3

LOCATION

TRAVEL DATE(S)

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

[REPLACE  WITH REPORTING AGENCY NAME]
National Guard Bureau 

NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

X

REPORTING 
PERIOD: 

OCTOBER 1, 
2018- MARCH 

31  2019

REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 

30, 2019



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right 
click, select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" 
checkbox at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left 
click the name of an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  
Select "OK".  A new sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.
To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that 
each tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that 
each tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent 
possible, agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All 
submissions must be made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still 
submit a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or 
the SF-326 (in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-
colored cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected 
so that you can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages 
refer to the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of 
the spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell 
to the left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-
agencies: Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the 
Department ABC worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's 
position in the workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The 
Department XYZ report would read 2 for Page-- referring to its order as the second report-- and 2 for Of 
Pages-- referring to the total number of sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the 
excel file as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency 
Name], [Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate 
information. If there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option 
to "Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the 
upper right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over 
the cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will 
remain highlighted.



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see 
how the file will look when it is printed.
Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission

Semiannual Report of Payment Accepted



Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President



Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acronym for your      



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC

    



EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP



OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

                 r agency, please contact OGE at 1353travel@oge.gov



PAGE OF PAGES YEAR

2019

Agency Contact: LTC May Nicholson

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Tami Biddle
Panel Presentation on 
intelligence and National 
Security

4/11/2019 Chaptel Hill, NC Transportation X $350.00 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging X $232.22 

Doctor University of North 
Carolina 4/13/2019 04/11/2019-

04/13/2019 Meals X $30.00 

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Christopher Bolan
Presentation on US 
Strategy in the Middle 
East

4/24/2019 Savannah, GA Transportation X $429.50 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging X $294.50 

Doctor Savannah Council on 
World Affairs 4/26/2019 04/24/2019-

04/26/2019                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Robert Hamilton

External Service and 
Outreach to Scholarly 
Community of Intest on 
Russia

4/25/2019 Philadelphia, PA Transportation X 55

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Lodging X 180

Professor Princeton University 4/26/2019 04/25/2019-
04/26/2019 Parking X 35

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

Departmant of the Army
Carlisle Barracks, US Army War Collge

NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

X

REPORTING 
PERIOD: 

OCTOBER 1, 
2018- MARCH 

31  2019

REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 

30, 2019

3

LOCATION

TRAVEL DATE(S)

Asia Pacific Forum 
Pacific Rim Foundation 

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

may.l.nicholson.mil@mail.mil

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

BENEFIT SOURCE

University of North 
Carolina

BENEFIT SOURCE

Savannah Council on 
World Affairs

BENEFIT SOURCE

Princeton University

BENEFIT SOURCE



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right 
click, select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" 
checkbox at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left 
click the name of an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  
Select "OK".  A new sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.
To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that 
each tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that 
each tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent 
possible, agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All 
submissions must be made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still 
submit a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or 
the SF-326 (in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-
colored cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected 
so that you can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages 
refer to the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of 
the spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell 
to the left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-
agencies: Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the 
Department ABC worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's 
position in the workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The 
Department XYZ report would read 2 for Page-- referring to its order as the second report-- and 2 for Of 
Pages-- referring to the total number of sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the 
excel file as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency 
Name], [Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate 
information. If there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option 
to "Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the 
upper right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over 
the cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will 
remain highlighted.



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see 
how the file will look when it is printed.
Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission

Semiannual Report of Payment Accepted



Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President



Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acronym for your      



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC

    



EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP



OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

                 r agency, please contact OGE at 1353travel@oge.gov



PAGE OF PAGES YEAR

1 8 2019

Agency Contact: Jan McNutt

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Nina Lauharatanahirun
Kavli Summer Cognitive 
Neuroscience Institute 
Conference

6/24/2019 Santa Barbara, CA Hotel X $2,145 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Meals X $912 

Research Psychologist, 
ARL University of California 7/5/2019 06/23/2019 - 

07/06/2019                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

David Wikner SPIE Defense and 
Commercial Sensing 2019 4/14/2019 Baltimore, MD Conference Fee 

Waiver X $1,005 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              

Physicist, ARL SPIE 4/18/2019 04/14/2019-
04/18/2019                            

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

Fikadu T. Dagefu
Invited Seminar at EE 
Dept at Univ of Wisconsin-
Madison

4/19/2019 Madison, WI Hotel X $393 

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Airfare X $436 

Electronics Engineer, 
ARL

University of Wisconsin-
Madison 19-Apr-19 04/18/2019-

04/20/2019                            

REPORTING 
PERIOD: 

OCTOBER 1, 
2018- MARCH 

31  2019

X

REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 

30, 2019

NEGATIVE 
REPORTCombat Capabilities Development Command

jan.s.mcnutt.civ@mail.mil

No.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

Department of Defense

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

TOTAL 
AMOUNT

BENEFIT 
DESCRIPTION

EX

LOCATION BENEFIT SOURCE

Asia Pacific Forum 
Pacific Rim Foundation 

TRAVEL DATE(S)

TRAVELER EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

BENEFIT SOURCE

2

LOCATION BENEFIT SOURCE

SPIE

TRAVEL DATE(S)

1

LOCATION BENEFIT SOURCE

University of California

TRAVEL DATE(S)

3

LOCATION BENEFIT SOURCE

University of Wisconsin-
Madison

TRAVEL DATE(S)



PAGE OF PAGES YEAR

1 4 2019

Agency Contact:  

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

     

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]    

                             

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

      

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              

                             

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

     

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]    

                              

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

 NEGATIVE 
REPORT

LOCATION AND 
TRAVEL DATE(S) 

[MM/DD/YYYY-
MM/DD/YYYY]

 

REPORTING 
PERIOD: 

OCTOBER 1, 
2018- MARCH 

31  2019

REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 

30, 2019

3

LOCATION

TRAVEL DATE(S)

Asia Pacific Forum 
Pacific Rim Foundation 

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

 

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

BENEFIT SOURCE

 

BENEFIT SOURCE

 

BENEFIT SOURCE

 

BENEFIT SOURCE



Completing the OGE Form-1353

Saving the Workbook

-

-

-

Preparing Blank Report Forms for Each Sub-Agency  (if applicable)

-

-

-

Completing the General Information

Renaming the Spreadsheet Tabs

-

-

-

-

Ensure use of standardized acronyms where applicable.

Spreadsheets can easily be copied by right-clicking on the sheet tab for the sheet you wish to copy.  After you right 
click, select "Move or Copy", which will open a dialogue box.  When the dialogue box appears, click the "Create a Copy" 
checkbox at the bottom of the dialogue box.  To determine the placement of the new sheet within your workbook, left 
click the name of an existing sheet in the "Before Sheet" area; your new sheet will be placed before the sheet selected.  
Select "OK".  A new sheet will appear (e.g. "RENAME BLANK FORM (2)") that you can rename.
To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that 
each tab must have a unique name. 

To rename the spreadsheet tab, simply double-click on the spreadsheet tab name and type the new name. Note that 
each tab must have a unique name. 

Rename the spreadsheet tab with your agency name, using standardized acronyms where applicable.

Instructions for § 1353 Travel Report

Starting with the October 1, 2010-March 31, 2011 reporting period, OGE will only accept § 1353 Travel Reports that are 
submitted electronically  in this OGE-approved electronic form (OGE Form-1353) or on the SF-326.   To the extent 
possible, agencies are strongly encouraged to submit their semiannual reports using the OGE Form-1353.  All 
submissions must be made via email to 1353Travel@oge.gov in XLS, XLSX, or PDF format.  

If your agency has not accepted payments under 31 U.S.C. §  1353 for the applicable reporting period, your agency must still 
submit a negative report.  Negative reports are indicated by an electronic submission of the OGE Form-1353 (in excel format) or 
the SF-326 (in PDF Format).

The United States Office of Government Ethics (OGE) is required by 31 U.S.C. § 1353 to collect and make publicly available the 
information submitted in the semiannual  § 1353 travel reports.  OGE's acceptance of this information does not constitute a 
determination that the information is adequate or concurrence with the submitting agency’s conflict of interest analysis.  (See  41 
CFR §304-6.9).  

Name the Workbook using your agency acronym and the reporting period using this convention:  
1353Report_[AgencyAcronym]_[Reporting Period].xls, for example 1353Report_OGE_OctMarch2011.xls.  

Use OctMarch[Year] for the October 1- March 31st reporting cycle and AprSept[Year] for the April 1-September 30th 
reporting cycle.
Note that your agency acronym can be found on the worksheet titled "Agency Acronym" (tab located at the bottom of the 
workbook).

Select the Microsoft Button and choose "Save As" Excel Workbook from the menu. When typing the file name, use the 
naming convention: 1353Report_[AgencyAcroynm]_[Reporting Period].xls

Fill in the white-colored cells found below Page, Of Pages, and Year. 

Fill in the applicable information.  Note that information to be completed by the agency always appears in white-
colored cells.  Information located in the colored cells should not be manipulated. The worksheet has been protected 
so that you can tab between the fillable cells.

Filling in Page, Of Pages and  Year

Page refers to the numerical position of the current sheet relative to the other sheets in the workbook and Of Pages 
refer to the total number of report pages in the entire workbook.  

For each individual sub-agency report, copy the "RENAME BLANK FORM" spreadsheet (tab located at the bottom of the 
workbook) and rename it to describe the sub-agency. 



-

-

-

-

Filling in Travel Specific Information

Indicating a Negative Report
-

-

Submitting the Report to OGE

Printing Reports for Internal Agency Use and Record Keeping

In Excel 2007
-

-

-

-

-

In Excel 2003
-

-

Fill in the applicable information in the report in the same method as illustrated by the example. You must enter the 
information in the cell below the description of the type of information.  For example, type "John Smith" in the cell below 
"Name."

Indicating 1353 Travel

Once the identifying information is completed correctly, the report title should automatically read correctly at the top of 
the spreadsheet.

If there is no information to report for this reporting period, indicate the negative report by placing an X in the white cell 
to the left of negative report.

For example, if the Department of Example 1353 Travel Report had submissions from its only two sub-
agencies: Department ABC and Department XYZ, there would be 2 total reports (2 worksheets).  On the 
Department ABC worksheet/report, the agency would enter 1 for Page-- referring to the Department ABC's 
position in the workbook-- and 2 for Of Pages-- referring to the total number of worksheets/reports.  The 
Department XYZ report would read 2 for Page-- referring to its order as the second report-- and 2 for Of 
Pages-- referring to the total number of sheets in the workbook.

Filling in Agency Name, Sub-Component Name, and Contact Information

Indicating Reporting Period

Ensure the file is saved using the naming convention discussed in the instruction for saving the workbook, and email the 
excel file as an attachment to 1353Travel@oge.gov.  

In the fillable cells below the Title, replace [Replace with Reporting Agency Name], [Replace with Sub-Agency 
Name], [Replace with Agency Contact Name], and [Replace with Agency Contact Email] with the appropriate 
information. If there is no sub-agency, then delete [Sub-Agency] from that cell.  

Indicate the reporting period by placing an X in the white cell to left of the correct reporting period.

While reports must be submitted electronically, your agency may find it useful to print its 1353 Travel Reports for record-keeping 
purposes. The following instructions provide guidance for printing in Excel 2003 and Excel 2007.

Highlight the portion of the report on each spreadsheet you would like to print.  Do this by left-clicking with the mouse and 
holding the button as you drag the cursor over the cells that you wish to highlight. Release the mouse button when you are 
finished and the area that you selected will remain highlighted. Click on the Page Layout Tab on the Microsoft Excel Ribbon.  
With the printing area highlighted, click the "Print Area" button, which should provide a drop-down menu including the option 
to "Set Print Area". Select "Set Print Area". 

On the Page Layout Tab, locate the "Scale to Fit" option.  Use the drop-down menu to restrict the width to "1 page".

Access the print properties menu. Scroll to the “File” tab on the command bar and select “Print Area.”

To verify the margins are correct on your printing job, use the Print Preview option.  Click on the Microsoft button in the 
upper right-hand corner and hover over Print.  Select "Print Preview" from the right-hand menu.
You can select Print from the Print Preview view or Print as you traditionally would.

Highlight the desired print area. Do this by left-clicking with the mouse and holding the button as you drag the cursor over 
the cells that you wish to highlight. Release the mouse button when you are finished and the area that you selected will 
remain highlighted.



-

-

-

Set the print area. A submenu will open. Scroll to “Set Print Area” and left-click to set the print area. The print area will be 
outlined with a dashed border inside of the spreadsheet.

Check the print area in the preview screen. Scroll to the “File” tab on the command bar and select “Print Preview” to see 
how the file will look when it is printed.
Adjust the print area. To make any changes, just hover the mouse over a corner of the dashed border surrounding the print 
area. When the cursor turns to a cross-sectioned arrow, left-click and hold. Drag the print area to the desired size.



Agency/Sub-Agency Name
Administrative Conference of the United States
Advisory Council on Historic Preservation
African Development Foundation
Agency for International Development
American Battle Monuments Commission
Appalachian Regional Commission
Appraisal Subcommittee
Arctic Research Commission
Armed Forces Retirement Home (Soldiers' & Airmen's Home)
Armed Services Board of Contract Appeals-- Department of Defense
Barry Goldwater Scholarship Foundation
Broadcasting Board of Governors
Central Intelligence Agency
Chemical Safety & Hazard Investigation Board
Christopher Columbus Fellowship Foundation
Comission on Civil Rights
Commision of the Fine Arts
Commission for Purchase from the Blind & Severely Disabled
Commission for the Preservation of America's Heritage Abroad
Commodity Futures Trading Commission
Consumer Product Safety Commission
Corporation for National & Community Service
Council of Econimic Advisors-- Executive Office of the President
Council on Environmental Quality-- Executive Office of the President
Court Services & Offender Supervision Agency for DC
Defense Commissary Agency-- Department of Defense
Defense Contract Audit Agency-- Department of Defense
Defense Finance & Accounting Service-- Department of Defense
Defense Information Systems Agency-- Department of Defense
Defense Intelligence Agency-- Department of Defense
Defense Logistics Agency-- Department of Defense
Defense Nuclear Facilities Safety Board
Defense Security Service-- Department of Defense
Defense Threat Reduction Agency-- Department of Defense
Department of Agriculture
Department of Commerce
Department of Defense
Department of Education
Department of Energy
Department of Health & Human Services
Department of Homeland Security
Department of Housing & Urban Development
Department of Justice
Department of Labor
Department of State
Department of the Air Force-- Department of Defense
Department of the Army-- Department of Defense
Department of the Interior
Department of the Navy-- Department of Defense
Department of Transporation
Department of Treasury
Department of Veterans Affairs
Election Assistance Commission

Semiannual Report of Payment Accepted



Enviornmental Protection Agency
Equal Employment Opportunity Commission
Executive Office of the President
Export-Import Bank
Farm Credit Administration & Farm Systems Insurance Corporation
Federal Communications Commission
Federal Deposit Insurance Corporation
Federal Election Commission
Federal Energy Regulation Commission
Federal Housing Finance Board
Federal Labor Relations Authority
Federal Maritime Commission
Federal Mediation & Concilitation Service
Federal Mine Safety & Health Review Commission
Federal Reserve System
Federal Retirement Thrift Investment Board
Federal Trade Commission
General Services Administration
Government Accountability Office
Harry S. Truman Scholarship The Truman Foundation
Institute of Museum & Library Services
Inter-American Foundation
International Boundary & Water Commission
International Joint Commission
International Trade Commission
James Madison Memorial Fellowship Foundation
Japan/US Friendship Commission
Marine Mammal Commission
Merit System Protection Board
Millennium Challenge Corporation
Morris K. Udall Foundation
National Aeronautics & Space Administration
National Archives & Records Administration
National Capital Planning Commission
National Credit Union Administration
National Endowment for the Arts
National Endowment for the Humanities
National Imagery & Mapping Agency/National Geo-Space Intelligence-- Department of Defense
National Intelligence, Office of the Director
National Labor Relations Board
National Mediation Board
National Science Foundation
National Security Agency-- Department of Defense
National Security Council-- Executive Office of the President
National Tranpsortation Safety Board
Nuclear Regulatory Commission
Nuclear Waste Technical Review Board
Occupational Safety & Health Review Commission
Office of Administration-- Executive Office of the President
Office of Government Ethics
Office of Management and Budget-- Executive Office of the President
Office of National Drug Control Policy
Office of Navajo & Hopi Indian Relocation
Office of Personnel Management
Office of Science & Technology Policy-- Executive Office of the President



Office of Special Counsel
Office of the Federal Coordinator for Alaska Natural Gas Transporation Project
Office of the Inspector General-- Department of Defense
Office of the Inspector General for Afghanistan Reconstruction
Office of the Secretary-- Department of Defense
Office of the Vice President-- Executive Office of the President
Office of US Trade Representative-- Executive Office of the President
Overseas Private Investment Corporation
Peace Corps
Pension Benefit Guaranty Corporation
Postal Rate Commission
Railroad Retirement Board
Recovery Accountability & Transparency Board
Securities & Exchange Commission
Selective Service System
Small Business Administration
Social Security Adminstration
Special Inspector General for Iraq Reconstruction 
Surface Transporation Board
Tennessee Valley Authority
The President's Council on Bioethics
The Presidio Trust
The White House Office-- Executive Office of the President
Uniformed Services University of the Health Science-- Department of Defense
US Access Board
US Trade & Development Agency

If your agency is not listed here or if you have questions about the standard acronym for your      



Acronym
ACUS
ACHP
AFDF
AID
ABMC
ARC
ASC
ARTIC
AFRH
ASBCA
BGSF
BBG
CIA
CSHIB
CCFF
CCR
CFA
CPBSD
CPAHA
CFTC
CPSC
CNCS
CEA
CEQ
CSOSA
DCA
DCAA
DFAS
DISA
DIA
DLA
DNFSB
DSS
DTRA
USDA
DOC
DOD
DOED
DOE
HHS
DHS
HUD
DOJ
DOL
STATE
DAF
ARMY
DOI
NAVY
DOT
TREASURY
VA
EAC

    



EPA
EEOC
EOP
EX-IM BANK
FCA
FCC
FDIC
FEC
FERC
FHFB
FLRA
FMC
FMCS
MSHRC
FRS
FRTIB
FTC
GSA
GAO
HTS
IMLS
IAF
IBWC
IJC
ITC
JMM
JFC
MMC
MSPB
MCC
MUF
NASA
NARA
NCPC
NCUA
NEA
NEH
DMA
DNI
NLRB
NMB
NSF
NSA
NSC
NTSB
NRC
NWTRB
OSHRC
OA
OGE
OMB
ONDCP
ONHIR
OPM
OSTP



OSC
ANGTP
OIG(DOD)
SIGAR
OS(DOD)
OVP
USTR
OPIC
PEACE
PBGC
PRC
RRB
RAT BOARD
SEC
SSS
SBA
SSA
SIGIR
STB
TVA
PCB
PRESIDIO
WH
USUHS
ACCESS
USTDA

                 r agency, please contact OGE at 1353travel@oge.gov



PAGE OF PAGES YEAR

1 1 2019

Agency Contact:
Ms. Carolyn G. 
Morris

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]

John Smith Conference on Asia-
Pacific Relations 8/11/2011 San Francisco, CA Hotel X $280

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY] Air Transportation X $825

Secretary Asia-Pacific Forum 8/12/2011 8/11/2011-8/13/2011 Meals X $120

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              

                           

TRAVELER NAME EVENT DESCRIPTION BEGINNING DATE 
[MM/DD/YYYY]                               

                              

TRAVELER TITLE EVENT SPONSOR ENDING DATE 
[MM/DD/YYYY]                              

                           

BENEFIT 
DESCRIPTION

TOTAL 
AMOUNT

Department of the Army
U.S. Army Cyber Command NEGATIVE 

REPORT
LOCATION AND 

TRAVEL DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]

X

REPORTING 
PERIOD: 

OCTOBER 1, 
2018- MARCH 

31, 2019

REPORTING 
PERIOD: APRIL 
1 - SEPTEMBER 

30, 2019

3

LOCATION

TRAVEL DATE(S)

Asia Pacific Forum 
Pacific Rim Foundation 

2

EX

TRAVEL DATE(S)

LOCATION

LOCATION

TRAVEL DATE(S)

1

LOCATION

TRAVEL DATE(S)

carolyn.g.morris3.civ@mail.mil

TRAVELER 

No.

This report implements 31 U.S.C. § 1353.  It does not supersede other reports that may have to be filed when travel expenses are accepted under other authority.  
For definitions and policies, see 41 CFR part 304-1.

SEMIANNUAL REPORT OF PAYMENTS ACCEPTED FROM A NON-FEDERAL SOURCE

PAYMENT 
BY CHECK

PAYMENT 
IN-KIND

EVENT DESCRIPTION & 
EVENT SPONSOR

EVENT DATE(S) 
[MM/DD/YYYY-
MM/DD/YYYY]:

BENEFIT SOURCE

BENEFIT SOURCE

BENEFIT SOURCE

BENEFIT SOURCE

BENEFIT SOURCE
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